What is Visual Basic?

· Visual Basic is a tool that allows you to develop Windows (Graphic User Interface - GUI) applications.  The applications have a familiar appearance to the user.  As you develop as a Visual Basic programmer, you will begin to look at Windows applications in a different light.  You will recognize and understand how various elements of Word, Excel, Access and other applications work.  You will develop a new vocabulary to describe the elements of Windows applications.

· Visual Basic is event-driven, meaning code remains idle until called upon to respond to some event (button pressing, menu selection, ...).  Visual Basic is governed by an event processor.  Nothing happens until an event is detected.  Once an event is detected, the code corresponding to that event (event procedure) is executed.  Program control is then returned to the event processor.
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Structure of a Visual Basic Application

Project (.VBP, .MAK)





Application (Project) is made up of:

· Forms - Windows that you create for user interface

· Controls - Graphical features drawn on forms to allow user interaction (text boxes, labels, scroll bars, command buttons, etc.)  (Forms and Controls are objects.)

· Properties - Every characteristic of a form or control is specified by a property.  Example properties include names, captions, size, color, position, and contents.  Visual Basic applies default properties.  You can change properties at design time or run time.

· Methods - Built-in procedure that can be invoked to impart some action to a particular object.

· Event Procedures - Code related to some object.  This is the code that is executed when a certain event occurs.

· General Procedures - Code not related to objects.  This code must be invoked by the application.

· Modules - Collection of general procedures, variable declarations, and constant definitions used by application. 

Steps in Developing Application

· The Visual Basic development environment makes building an application a straightforward process.  There are three primary steps involved in building a Visual Basic application: 

1. Draw the user interface by placing controls on the form

2. Assign properties to controls

3. Attach code to control events (and perhaps write other procedures)

These same steps are followed whether you are building a very simple application or one involving many controls and many lines of code.

Starting Visual Basic

· We assume you have Visual Basic 6 installed and operational on your computer.  If you don’t, you need to do this first.  To start Visual Basic:

· Click on the Start button on the Windows task bar.

· Select Programs, then Microsoft Visual Basic 6
· Click on Visual Basic 6
(Some of the headings given here may differ slightly on your computer, but you should have no trouble finding the correct ones.)  

Visual Basic will start and this dialog box appears:
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For now, just click Open – we are starting a new project.  Later, once you have saved some projects, they can be opened using the Existing and Recent tabs.  The Visual Basic development environment will start.

Drawing the User Interface and Setting Properties

Visual Basic operates in three modes.

· Design mode - used to build application

· Run mode - used to run the application

· Break mode - application halted and debugger is available

We focus here on the design mode.


Six windows appear when you start Visual Basic.  Each window can be viewed (made visible) by selecting menu options, depressing function keys or using the toolbar.  Use the method you feel most comfortable with.

· The Main Window consists of the title bar, menu bar, and toolbar.  The title bar indicates the project name, the current Visual Basic operating mode, and the current form.  The menu bar has drop-down menus from which you control the operation of the Visual Basic environment.  The toolbar has buttons that provide shortcuts to some of the menu options.  The main window also shows the location of the current form relative to the upper left corner of the screen (measured in twips) and the width and length of the current form.  Of particular interest is the Help menu item.  The Visual Basic on-line help system is invaluable as you build applications.  Become accustomed with its use.  Usually just pressing <F1> can get you the help you need.




· The Form Window is central to developing Visual Basic applications.  It is where you draw your application. 




· The Toolbox is the selection menu for controls used in your application.  Help with any control is available by clicking the control and pressing <F1>.

 


· The Properties Window is used to establish initial property values for objects (controls).  The drop-down box at the top of the window lists all objects in the current form.  Two views are available:  Alphabetic and Categorized.  Under this box are the available properties for the currently selected object.  Help with any property can be obtained by highlighting the property of interest and pressing <F1>. 
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· The Form Layout Window shows where (upon program execution) your form will be displayed relative to your monitor’s screen:




· The Project Window displays a list of all forms and modules making up your application.  You can also obtain a view of the Form or Code windows (window containing the actual Basic coding) from the Project window. 
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· As mentioned, the user interface is ‘drawn’ in the form window.  There are two ways to place controls on a form:

1. Double-click the tool in the toolbox and it is created with a default size on the form.  You can then move it or resize it.

2. Click the tool in the toolbox, then move the mouse pointer to the form window.  The cursor changes to a crosshair.  Place the crosshair at the upper left corner of where you want the control to be, press the left mouse button and hold it down while dragging the cursor toward the lower right corner.  When you release the mouse button, the control is drawn.

· To move a control you have drawn, click the object in the form window and drag it to the new location.  Release the mouse button.

· To resize a control, click the object so that it is select and sizing handles appear.  Use these handles to resize the object.  
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
A convention has been established for naming Visual Basic objects.  This convention is to use a three letter prefix (depending on the object) followed by a name you assign.  A few of the prefixes are (we’ll see more as we progress in the class):

Object   

Prefix    

Example
Form 


frm  


frmWatch

Command Button 
cmd, btn   

cmdExit, btnStart

Label  

lbl


lblStart, lblEnd

Text Box  

txt


txtTime, txtName

Menu  

mnu


mnuExit, mnuSave

Check box  

chk


chkChoice


Object (control) names can be up to 40 characters long, must start with a letter, must contain only letters, numbers, and the underscore (_) character.  Names are used in setting properties at run time and also in establishing procedure names for object events.  Use meaningful object names that help you (or another programmer) understand the purpose of the respective controls.

Setting Properties at Run Time


You can also set or modify properties while your application is running.  To do this, you must write some code.  The code format is:

ObjectName.Property = NewValue

Such a format is referred to as dot notation.  For example, to change the BackColor property of a form name frmStart, we'd type:  

frmStart.BackColor = vbBlue

How Names are Used in Control Events

The names you assign to controls are used by Visual Basic to set up a framework of event-driven procedures for you to add code to.  The format for each of these subroutines (all event procedures in Visual Basic are subroutines) is:

Private Sub ObjectName_Event (Optional Arguments)


.


.

End Sub


Visual Basic provides the Sub line with its arguments (if any) and the End Sub statement.  You provide any needed code.

Writing Code
· The last step in building a Visual Basic application is to write code using the BASIC language.  This is the most time consuming task in any Visual Basic application.  As controls are added to a form, Visual Basic automatically builds a framework of all event procedures.  We simply add code to the event procedures we want our application to respond to.  And, if needed, we write general procedures.  For those who may have never programmed before, the code in these procedures is simply a line by line list of instructions for the computer to follow.

· Code is placed in the code window.  Learn how to access the code window using the menu (View), toolbar, or by pressing <F7> (and there are still other ways).  At the top of the code window are two boxes, the object (or control) list and the procedure list.  Select an object and the corresponding event procedure.  A  blank procedure will appear in the window where you write BASIC code.

Variables

· We’re now ready to attach code to our application.  As controls are added to the form, Visual Basic automatically builds a framework of all event procedures.  We simply add code to the event procedures we want our application to respond to.  But before we do this, we need to discuss variables.  

· Variables are used by Visual Basic to hold information needed by your application.  Rules used in naming variables:

· No more than 40 characters

· They may include letters, numbers, and underscore (_)

· The first character must be a letter

· You cannot use a reserved word (word needed by Visual Basic)

Use meaningful variable names that help you (or other programmers) understand the purpose of the information stored by the variable.

Visual Basic Data Types 

Data Type
Suffix
Example

Boolean
None
True

Integer
%
14

Long (Integer)
&
4532838

Single (Floating)
!
3.23

Double (Floating)
#
3.2346363627281

Currency
@
$12.98

Date
None
12/30/99

Object
None
n/a

String
$
“Visual Basic 6”

Variant
None
any
Variable Declaration

There are three ways for a variable to be typed (declared):

1. Default

2. Implicit

3. Explicit


If variables are not implicitly or explicitly typed, they are assigned the variant type by default.  The variant data type is a special type used by Visual Basic that can contain numeric, string, or date data.


To implicitly type a variable, use the corresponding suffix shown above in the data type table.  For example,

TextValue$ = "This is a string"

creates a string variable, while

Amount% = 300

creates an integer variable.  Implicit variable typing is recognized by Visual Basic to insure compatibility with older versions of the BASIC language.


There are many advantages to explicitly typing variables.  Primarily, we insure all computations are properly done, mistyped variable names are easily spotted, and Visual Basic will take care of insuring consistency in upper and lower case letters used in variable names.  Because of these advantages, and because it is good programming practice, we will explicitly type all variables.


To explicitly type a variable, you must first determine its scope.  There are four levels of scope:

· Procedure level

· Procedure level, static

· Form and module level

· Global level

· The value of procedure level variables are only available within a procedure.  Such variables are declared within a procedure using the Dim statement: 

Dim MyInt as Integer

Dim MyDouble as Double

Dim MyString As String, YourString as String

Procedure level variables declared in this manner do not retain their value once a procedure terminates.


To make a procedure level variable retain its value upon exiting the procedure, replace the Dim keyword with Static:

Static MyInt as Integer

Static MyDouble as Double


Form (module) level variables retain their value and are available to all procedures within that form (module).  Form (module) level variables are declared in the declarations part of the general object in the form's (module's) code window.  The Dim keyword is used:

Dim MyInt as Integer

Dim MyDate as Date


Global level variables retain their value and are available to all procedures within an application.  Module level variables are declared in the declarations part of the general object of a module's code window.  (It is advisable to keep all global variables in one module.)  Use the Global keyword:

Global MyInt as Integer

Global MyDate as Date

· What happens if you declare a variable with the same name in two or more places?  More local variables shadow (are accessed in preference to) less local variables.  For example, if a variable MyInt is defined as Global in a module and declared local in a routine MyRoutine, while in MyRoutine, the local value of MyInt is accessed.  Outside MyRoutine, the global value of MyInt is accessed.

· Example of Variable Scope:

Module1

Global X as Integer
Form1
Form2

Dim Y as Integer

Dim Z as Single

Sub Routine1()

Sub Routine3()

  Dim A as Double

  Dim C as String

  .

  .

  .
  
  .



End Sub

End Sub

Sub Routine2()

  Static B as Double

  .

 .

End Sub

Procedure Routine1 has access to X, Y, and A (loses value upon termination)

Procedure Routine2 has access to X, Y, and B (retains value)

Procedure Routine3 has access to X, Z, and C (loses value)

Quick Primer on Saving Visual Basic Applications: 

When saving Visual Basic applications, you need to be concerned with saving both the forms (.FRM) and modules (.BAS) and the project file (.VBP).  In either case, make sure you are saving in the desired directory.  The current directory is always displayed in the Save window.  Use standard Windows techniques to change the current directory.

The easiest way to save a new project is to click the Save Project button (it looks like a floppy disk) on the Visual Basic toolbar.  First, you will be asked where you want to save your forms and modules, then where you want to save your project file.  Once you’ve done this, subsequent clicking on the Save Project toolbar button will automatically save your forms, modules, and project file in their specified locations.  To open a saved project, simply click the Open Project button (looks like a file folder).

If your prefer to save without the toolbar, there are four Save commands available under the File menu in Visual Basic:

Save [Form Name]
Save the currently selected form or module with the current name.  The selected file is identified in the Project window.

Save [Form Name] As
Like Save File, however you have the option to change the file name

Save Project
Saves all forms and modules in the current project using their current names and also saves the project file.

Save Project As
Like Save Project, however you have the option to change file names.  When you choose this option, if you have not saved your forms or modules, you will also be prompted to save those files.  I always use this for new projects.

There is a corresponding Open command under the File menu to open project files.
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